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Chapter 17: Hypertext and view-only 
documents

About online systems
You can distribute hypertext documents online as part of an online system. Readers can then page through the 
contents sequentially or explore at random, following the links you provide. You can create a simple online system 
from documents that you print (including a table of contents and index that contain hypertext links), or you can 
create a more elaborate online environment that contains extensive navigation aids such as document maps and 
navigation buttons. 

When you set up an online system, you create a series of hypertext documents. In each document, you designate 
active areas. An active area contains a hypertext command that instructs FrameMaker how to respond when a reader 
clicks there.

For example, readers might click in a list to learn about a specific item, click part of a graphic for a more detailed 
drawing of that part, or click in an index for information about the indexed term. They can choose a topic from a 
pop-up menu, or they can click buttons to navigate through a document.

Click an active area to display related information.

Distributing hypertext documents
You can save a document in Portable Document Format (PDF) or in Hypertext Markup Language (HTML) format 
for distribution on the World Wide Web or on an intranet.

You can also distribute your hypertext documents to readers in View Only format. Readers can use FrameMaker to 
open, read, search, and print such documents and they can use the embedded hypertext links, but they can’t edit 
the documents. 

Klaus
Sticky Note
Excerpt from FM-8 doc User GuideH:\Adobe\framemaker.8en\Documents\UserGuide.pdf
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Planning online systems
Creating effective and easy-to-use online documents takes careful planning. You need to design a page size and 
layout that’s appropriate for the type of computer the document will be read from and for the type of reader who will 
use it. Well-designed online systems often include graphics or symbols (in the same place on each page) that the 
reader can click to navigate through the system. 

Navigation aids are important in an online system.

When creating documents for online distribution, follow these simple guidelines:

• Write several short documents rather than one long one. A long document takes longer to open.

• Keep all the documents that make up the system together in one folder. Then you won’t have to keep track of 
pathnames for imported graphics and for hypertext commands that require filename specifications.

• If you’ll distribute the documents as FrameMaker files, use fonts that are readily available. You may want to 
use fonts such as Times and Helvetica because these fonts are available on most computers and on all 
PostScript printers.

Preparing areas for becoming active
A reader navigates through a hypertext system by clicking active areas—areas containing hypertext commands—or 
by scrolling up or down. An active area can be a range of text, a graphic, or a part of a graphic. You can set up active 
areas on body pages, or you can set them up on master pages so they appear in the same location on all body pages. 
For example, you can set up navigational buttons on master pages. When a reader clicks on an active area, the area’s 
hypertext command is executed.
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Before you insert a hypertext command, you prepare the area. For example, you can prepare a range of text by 
making it visually different from surrounding text. 

Underlined text on body page can be active.

Graphics on master pages can be active.

Preparing text areas
A text area can be a word, a phrase, or an entire paragraph. If your reader clicks in a text area that contains a hypertext 
command, FrameMaker finds the hypertext command, highlights the area, and performs the command.

To prepare a text area:
❖ Do one of the following:

• To designate a word or a phrase as an active area, select the text and change its character format. Changing the 
character format defines the boundaries of the text area. Most formatting differences are recognized. Only pair 
kerning, spread, stretch, change bars, language, and case are ignored.

To designate a word or phrase as an active area without changing its appearance, use a character format that sets 
all properties to As Is (see“Using As Is” on page 105 and “Applying predefined formats to text” on page 102).

• To designate an entire paragraph as an active area, make sure the paragraph contains no character format changes. 
As long as the paragraph contains only one hypertext command and no character format changes, FrameMaker 
highlights the entire paragraph and performs the command when a reader clicks anywhere in the paragraph.

• To designate several adjacent words or phrases in a text string as active areas, use the same character format for 
the entire text string. Then insert the various hypertext commands. FrameMaker divides the text into active areas 
based on the locations of the markers. When a reader clicks in the text, FrameMaker determines which active area 
was clicked and executes the correct hypertext command.

Markers divide text into active areas.
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Preparing graphics
Graphics often provide visual cues for hypertext actions. For example, readers can click an icon to display infor-
mation on a topic, or an arrow to display the next page.

An active area over a graphic can contain a hypertext command that jumps to another location or one that divides 
the graphic into a matrix of hypertext commands. 

Note: If you’re preparing documents for distribution in HTML format, you can use active areas over anchored graphics 
to create image maps. Unanchored graphics on master and body pages won’t be converted to HTML.

To prepare a graphic:
1 Draw a text frame that covers the entire graphic you want to make active. Later, you’ll place a hypertext command 
in the text frame. (When the reader clicks an active text frame, FrameMaker will highlight the entire frame.) For 
information on using the Text Frame tool to draw a frame, see “Using text with graphics” on page 320.

Make sure that the graphic is not set to have text run around it (see “Running text around graphics” on page 325).

2 Set the text frame’s fill and pen patterns to None (see “Applying and changing drawing properties” on page 315). 
This makes the text frame transparent so that readers see the graphic behind the frame.

3 Choose Graphics > Bring to Front to place the text frame in front of the graphic, if it isn’t already there. 
(Unless you placed the graphic on the page after drawing the text frame, the text frame will already be in front of 
the graphic.)

Preparing the same area on multiple pages
You can create an area that appears in the same location on more than one page. You do this by setting up the area 
on a master page and inserting the hypertext command there. For example, you can create buttons on master pages 
that readers can click on body pages to display the next or previous page. 

Navigation buttons on master page appear on body pages.

You can override active master page graphics on individual body pages if you want to send the reader somewhere 
else. For example, you can create a Next Page button with an override on the last body page of each document 
because there is no next page to display. 

To have an active area appear on more than one page:
❖ Set up the area on a master page rather than on a body page (see “Preparing text areas” on page 523 and “Preparing 
graphics” on page 524). The active area appears in the background of corresponding body pages. When your reader 
clicks that area on a body page, the hypertext command on the master page is activated. 

When you draw the text frame on a master page, FrameMaker asks whether you want to create a template frame or 
a background frame. Text frames for active areas should be background (untagged) text frames.
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To override a master page command on an individual body page:
❖ Do one of the following:

• Put a graphic or a different hypertext command over the area on the body page. For example, you can create an 
inactive, shaded button covering the Next Page button on the last body page of each document.

Master page commands can be overridden by graphics on body pages. 

• Place a text frame that contains its own hypertext command over the graphic on the body page.

Inserting hypertext commands
You use a marker to insert a hypertext command in a prepared area. After you insert a command and save the 
document in View Only format, the area becomes active. When a reader clicks an active area, FrameMaker highlights 
the area and executes the command. 

Hypertext commands let your readers navigate through the view-only documents. If you’re distributing the 
documents in View Only format, hypertext commands can also display alerts, close documents, exit FrameMaker, 
and start other applications. 

Hypertext command marker

After inserting a hypertext command, you can test the command without saving the document in View Only format 
(see “Working in view-only documents and books” on page 544).

Note: To insert a hypertext command in a text inset, insert the command in the text inset’s source document.

To insert a hypertext command:
1 Click in a prepared area where you want to insert a hypertext command. (For details, see “Preparing areas for 
becoming active” on page 522.) You can insert hypertext commands in text frames but not in text lines (graphic 
objects created with the Text Line drawing tool). To prevent extra spacing in the hypertext command when 
exporting, insert your markers at the beginning or end of a word.

2 Choose Special > Hypertext.
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3 Choose a hypertext command from the Command pop-up menu. The syntax for the command appears below the 
pop-up menu, and the command name appears in the text box. (For a description of the items in the Command 
pop-up menu, see “Hypertext commands” on page 527.)

4 Enter parameters in the text box as needed (for example, a filename and linkname). For details, see “Creating 
hypertext links” on page 529 and the sections that follow it.

Hypertext commands must always appear in lowercase. The parameters can be uppercase or lowercase, but they are 
case-sensitive. The entire command can be up to 255 characters long. (Each character in a Japanese font counts as 
two characters.)

Note: If you enter a filename parameter for a file that isn’t in the same folder as the current document, you must specify 
a path to the document (see “About pathnames in commands” on page 528).

5 If you want FrameMaker to validate the command when you insert it, select Validate Command upon Insertion.

6 Click New Hypertext Marker. FrameMaker checks the syntax in the text box. If Validate Command upon 
Insertion is selected, FrameMaker also validates the command. For example, FrameMaker validates a Jump to 
Named Destination command by verifying that the destination link exists in the specified document. 

If FrameMaker finds an error, an alert message describes it, but the command is still inserted in a marker of type 
Hypertext. A marker symbol  appears at the insertion point when text symbols are visible. 

Note: Hypertext markers support the Unicode text encoding standard.

To edit a hypertext command:
1 If the document is in View Only format, do one of the following to change it to Document format:

• If the Hypertext dialog box is open, click Make Editable.

• Press Esc Shift+f l (lowercase L) k.

2 Choose Special > Hypertext if the Hypertext dialog box isn’t open. 

3 Select the marker that contains the command you want to edit. To select a marker in an otherwise empty text 
frame, double-click anywhere in the frame. You can also use the Find command to find and select hypertext markers. 
The hypertext command appears in the Hypertext dialog box. 

If no other markers appear near the marker you want to edit, drag through the marker to display its hypertext 
command in the Hypertext dialog box.

4 Edit the command in the text box, and click Edit Hypertext Marker. Even if text around the marker is selected, 
only the command in the marker is affected.

5 If you want to return the document to View Only format, do one of the following:

• Click Make View Only in the Hypertext dialog box.

• Press Esc Shift+f l (lowercase L) k.

To delete a hypertext command:
❖ Select the marker that contains the command and press Delete. To select a marker in an otherwise empty text 
frame, double-click anywhere in the frame. You can also use the Find command to find and select hypertext markers. 
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Hypertext commands
FrameMaker supports the following hypertext commands. For a full description of each command and its syntax, 
see the cross-referenced information.

Alert Displays an alert box (see “Creating alert messages” on page 536).

Alert with Title Displays an alert box with a user-defined title (see “Creating alert messages” on page 536).

Specify Named Destination Marks the location that will be displayed when either a Jump to Named Destination or 
an Open Document command is executed (see “Creating links to specific topics” on page 530).

Jump to Named Destination Displays the location in the current or a different document that contains a corre-
sponding destination link (see “Creating links to specific topics” on page 530). The page is displayed in the 
active window. 

Jump to Named Destination & Fit to Page Displays the location in the current or a different document that contains 
a corresponding destination link and then resizes the window to fit the document page displayed (see “Creating links 
to specific topics” on page 530). 

Jump to First Page Displays the first page of the current or a different document (see “Creating links to pages” on 
page 531). The page is displayed in the active window.

Jump to Last Page Displays the last page of the current or a different document (see “Creating links to pages” on 
page 531). The page is displayed in the active window.

Go to URL Launches browser and displays the specified Web page (see “Creating links to Web pages” on page 532).

Jump to Page Number Displays a specific page in the current or a different document (see “Creating links to pages” 
on page 531). The page is displayed in the active window.

Jump to Previous Page Displays the previous page of the current document (see “Creating links to pages” on 
page 531). The page is displayed in the active window.

Jump to Next Page Displays the next page of the current document (see “Creating links to pages” on page 531). The 
page is displayed in the active window.

Jump Back Displays the last location the reader viewed (see “Creating a way to retrace steps” on page 533). The page 
is displayed in the active window.

Jump Back & Fit to Page Displays the last location the reader viewed and then resizes the window to fit the 
document page displayed (see “Creating a way to retrace steps” on page 533).

Open Document Displays the page that contains the corresponding Specify Named Destination command (see 
“Creating links to specific topics” on page 530). In Windows, the page appears in a new window (leaving the active 
window open) only if the page is in a different document. In UNIX, the page always appears in a different window.

Open Document & Fit to Page Displays the page that contains the corresponding Specify Named Destination 
command and then resizes the new window to fit the document page displayed (see “Creating links to specific topics” 
on page 530). In Windows, the page appears in a new window (leaving the active window open) only if the page is 
in a different document. In UNIX, the page always appears in a different window.

Open Document as New Opens a document as a new, unnamed document (see “Creating links to new documents” 
on page 532). The document is displayed in a new window, leaving the active window open.

Open Document at First/Last Page Displays the first or last page (see “Creating links to pages” on page 531). In 
Windows, the page appears in a new window (leaving the active window open) only if the page is in a different 
document. In UNIX, the page always appears in a different window.
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Open Document at Page Number Displays a specific page (see “Creating links to pages” on page 531). In Windows, 
the page appears in a new window (leaving the active window open) only if the page is in a different document. In 
UNIX, the page always appears in a different window.

Popup Menu Displays a pop-up menu of items, each containing a hypertext command (see “Creating pop-up 
menus” on page 534).

Button Matrix Allows the user to choose from a matrix of items that execute hypertext commands (see “Creating 
button matrices” on page 533).

Message Client Communicates with other applications (see “Creating ways to start or open” on page 537). Also 
creates a link to a URL (Universal Resource Locator) on the World Wide Web or an intranet for use in documents 
that are later converted to HTML (see “Setting up links to URLs” on page 551).

Close current window Removes the active window from the screen (see “Creating ways to close or exit” on 
page 539).

Close All Hypertext Windows Removes all view-only windows from the screen (see “Creating ways to close or exit” 
on page 539).

Exit Application Exits the FrameMaker application (see “Creating ways to close or exit” on page 539).

About pathnames in commands
Many hypertext commands can contain a pathname. In a pathname, folder levels are separated by a slash (/), even 
in Windows. In UNIX, the pathname can include environment variables, such as $HOME, to indicate the reader’s 
home directory. 

If your hypertext documents will be used on several platforms, use filenames that are valid on all the platforms. For 
information on file naming requirements on different platforms, see the online manual Working on 
Multiple Platforms.

Note: A hypertext command that contains a single-character filename may not work.

Relative pathnames FrameMaker searches for a relative pathname beginning in the folder that contains the current 
document. To go up one folder level, use two periods (..). For example, suppose a hypertext command refers to a 
document named Trombone that is stored in a folder named Brass. If the Brass folder is in the same folder as the 
current document, use the pathname Brass/Trombone. 

If the Brass folder is at the same level as the folder that contains the current document, use ../Brass/Trombone.

Absolute pathnames FrameMaker searches for an absolute pathname beginning at the top of the file system. 
In Windows, the absolute pathname begins with the drive specifier, a colon, and a slash. In UNIX, an absolute 
pathname begins with a slash.

For example, suppose a hypertext command refers to a document named Trombone in a folder named Brass. In 
Windows, if the Brass folder is at the top level of drive E, use the pathname E:/Brass/Trombone. In UNIX, if the Brass 
folder is at the top of the file system, use the pathname /Brass/Trombone. 

Absolute pathnames are not recognized across platforms, so you should always use relative pathnames if your 
hypertext documents will be viewed on multiple platforms.
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Hypertext commands in HTML and PDF documents
When you convert a document to HTML or PDF, some FrameMaker hypertext commands work in the converted 
files in the same way that they work in view-only FrameMaker documents, while others do not. The differences are 
described in the following table.
 

Creating hypertext links
You can create links to information in different locations in the same document or in different documents. For 
example, you can create links that jump to specific topics or pages, and you can use FrameMaker cross-references as 
links. You can also allow your readers to retrace their jumps.

If your documents will be distributed in PDF or HTML format, some of the commands described in this section will 
not work. For details, see “Hypertext commands in HTML and PDF documents” on page 529.

Command PDF HTML

Alert, Alert with Title Appears as a note, with no title Does not work

Jump to Named Destination Works as described in this chapter Works as described in this 
chapter

Jump to Named Destination & Fit to Page Works as described in this chapter, but 
doesn’t fit to page

Works as described in this 
chapter, but doesn’t fit to page

Jump to First Page, Jump to Last Page, Jump to Page 
Number, Jump to Previous Page, Jump to Next Page

Works as described in this chapter Does not work

Jump Back, Jump Back & Fit to Page Does not work Does not work

Open Document Works as described in this chapter Works as described in this 
chapter

Open Document & Fit to Page, Open Document as New, 
Open Document at First Page, Open Document at Last 
Page, Open Document at Page Number

Works as described in this chapter, but 
doesn’t fit to page or open a separate 
window

Works as described in this 
chapter, but doesn’t fit to page 
or open a separate window

Pop-up Menu Does not work Does not work

Button Matrix Does not work Works as described in this 
chapter, if the text frame 
containing the command is 
in an anchored frame in the 
main text flow

Message URL Works when PDF is opened in browser; 
however, the link may not work in 
Acrobat

Works as described in this 
chapter

Message Client Does not work Does not work

Close current window, Close All Hypertext Windows, Exit 
Application

Does not work Does not work
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Creating links to specific topics
You can create a link from one location in a hypertext document to a topic in another location. You use one 
command to specify the topic you want to display, and you use another to mark the spot on the linked page.

A. Specify the topic to display. B. Mark the topic.

FrameMaker can display the linked information in the same window or in a new window (leaving the active 
window open).

To identify a linked topic:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Specify Named Destination 
command. This command uses the following syntax:
newlink linkname 

In this example, linkname is a word or phrase that identifies the destination. A linkname with a trailing space differs 
from a linkname without a trailing space. Also, the linkname is case-sensitive; French Horn is not the same as french 
horn.

A. Jump to Named Destination command: gotolink trombone B. Specify Named Destination command: newlink trombone

Note: If you omit the Specify Named Destination command, the Jump to Named Destination and Open Document 
commands do nothing when clicked unless they refer to a filename. In that case, the other file will open, showing the 
first page.

To create a link to a specific topic:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert one of the following 
hypertext commands:

• To display the linked information in the same window, insert a Jump to Named Destination command. 
This command uses the following syntax:

gotolink filename:linkname 

A B

A B
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• To display the linked information in a different window, insert an Open Document command. (In Windows, the 
information appears in a new window only if it’s in a different document.) This command uses the following 
syntax: 

openlink filename:linkname 

In this example, filename is the name of the document you want to display, and linkname is the descriptive word or 
phrase that you used in the corresponding Specify Named Destination command. 

If the linked information is in a document whose page size differs from the current document’s, you can display the 
information in a window that is resized to fit the page. To do this, use the Jump to Named Destination & Fit to 

Page command or the Open Document & Fit to Page command.

Creating links to pages
You can create a link to the first, last, previous, or next page in the same document or in a different document. 
You can also create a link to a specific page number. 

You can create navigation aids for your readers by creating links to the next and previous pages on the master pages 
of a document.

To create a link to a page:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert one of the following 
hypertext commands:

• To display the linked page in the same window, insert a Jump to Page Number, Jump to First Page, or Jump to Last 
Page command. The commands use the following syntax:

gotopage filename:pagenumber 

gotopage filename:firstpage 

gotopage filename:lastpage 

• To display the linked page in a different window, insert an Open Document at Page Number, Open Document at 
First Page, or Open Document at Last Page command. (In Windows, the page appears in a new window only if 
the page is in a different document.) These commands use the following syntax:

openpage filename:pagenumber 

openpage filename:firstpage 

openpage filename:lastpage 

Note: When you insert a hypertext command to display a specific page number, use the actual page number in the 
document. For example, if the destination document MyDoc uses Roman numerals for page numbers and begins on page 
v, the command to display the third page would be openpage MyDoc:vii.

• To display the next or previous page of the current document, insert a Jump to Previous Page or Jump to Next Page 
command. (If the first page of the document is already displayed, Jump to Previous Page has no effect; if the last 
page of the document is displayed, Jump to Next Page has no effect.) These commands use the following syntax:

previouspage 

nextpage 



ADOBE FRAMEMAKER 8
User Guide

532

In these examples, filename is the name of the document you want to display, and pagenumber is the number of the 
page you want to display. When the page you want to display is in the current document, don’t include the filename 
and colon. The following table contains examples of the commands.

Creating links to new documents
You can create a link to another document and have FrameMaker open the document in another window as a new, 
unnamed document. For example, you can create an online system for your site’s document templates. 

To create a link to a new document:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert an Open Document as New 
command. This command uses the following syntax:

opennew filename 

In this example, filename is the name of the document you want to use as a template. 

Creating links to Web pages
You can create a link to a Web page on the Internet or a company intranet. 

To create a link to a Web page:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Go to URL command. 
This command uses the following syntax:
message URL address 

In this example, address is the name of the URL you want to jump to, such as http://www.adobe.com. 

Creating links using cross-references
You use FrameMaker cross-references as hypertext links. When the reader clicks a cross-reference in a view-only 
document, FrameMaker jumps to the source information. If a cross-reference is present in the same text area as a 
hypertext command, the cross-reference takes precedence over the hypertext command.

You can use MIF to specify that cross-references should not be active in your hypertext document. You can also 
specify that clicking an active cross-reference always causes FrameMaker to open a new window. For information on 
using MIF to customize hypertext documents, see the online manual MIF Reference.

Highlighting markers in view-only documents
When you click an active area in a view-only document, FrameMaker doesn’t usually select the cross-reference 
marker or the hypertext marker that identifies the linked information. (If the document is in FrameMaker 
Document format, the marker is selected.) You can use MIF to specify that the markers should be selected. 
For information on using MIF to customize hypertext documents, see the online manual MIF Reference.

Command Effect

gotopage 8 Displays, in the same window, page 8 of the current document

openpage Trombone:8 Displays, in a different window, page 8 of the document Trombone in the 
current folder
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Creating a way to retrace steps
You can create hypertext commands that allow readers to retrace the links they followed in a document window. 
(FrameMaker maintains a stack of the last 255 links in each window.) For example, you might use these commands 
on master pages to create a navigation aid that lets readers retrace their steps (for example, a “Go Back” button).

To create a way to retrace steps:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Jump Back command. 
This command uses the following syntax:
previouslink filename:linkname 

In this example, filename and linkname define the location FrameMaker should display when the stack is empty. If 
the stack is empty and if you haven’t provided a filename and linkname, FrameMaker leaves the current 
page displayed. 

If the linked information is in a document whose page size differs from the current document’s, you can display the 
information in a window that is resized to fit the page. To do this, use the Jump Back & Fit to Page command.

Creating button matrices
You can create a button matrix of equal-sized cells that correspond to hypertext commands. When a reader clicks a 
cell in a hypertext document, FrameMaker highlights the cell and executes the corresponding hypertext command. 
For example, the button matrix could be a group of musical instruments.

A button matrix with three cells

If the reader clicks one of the instruments, FrameMaker highlights the area around the instrument and executes the 
corresponding hypertext command. 

To create a button matrix:
1 Put the graphic in your document. The graphic should be appropriate for setting up as a matrix of 
equal-sized cells.

2 Prepare the graphic to be an active area by drawing a single text frame around the entire graphic (see “Preparing 
graphics” on page 524).

3 Click in the text frame to place the insertion point.

4 Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Button Matrix command in 
the text frame (leaving the frame otherwise empty). This command uses the following syntax:

matrix rows columns flowname 
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In this example, rows and columns are the numbers of rows and columns in the matrix, and flowname is the flow tag 
of a text frame you’ll create on a reference page. The flowname cannot contain embedded spaces. 

For the example shown earlier, with two rows and three columns, and with the corresponding hypertext commands 
in a reference page text frame whose flow tag is InstrumentTypes, the command would be as follows:

matrix 1 3 InstrumentTypes 

5 Draw a text frame on a reference page and assign a flow tag that matches the flowname in the Button Matrix 
command. For information on using the Text Frame tool to draw a text frame, see “Using text with graphics” on 
page 320. For information on assigning flow tags, see “Controlling the flow of text” on page 393.

6 Click in the text frame to place the insertion point, and then type one hypertext command in each paragraph in 
the text frame. The commands should correspond to the items in the first row of the matrix, from left to 
right, followed by the second row, and so on. Each command must fit on one line. You can resize the text frame 
if necessary.

The following illustration shows possible contents of the text frame for the example discussed at the beginning of 
this section.

Text frame on reference page

Note: You can use the Hypertext dialog box as an aid in identifying the syntax of the commands you need to type, but 
type the commands directly in the text frame. Don’t use the Hypertext dialog box to insert a hypertext marker.

Creating pop-up menus
Your hypertext document can display a pop-up menu from which readers can choose an item that links to related 
information. The pop-up menu can, in turn, contain one level of submenus.

Hypertext pop-up menu and submenu

To create a pop-up menu of hypertext commands:
1 Create the graphic button that the reader will click to display the pop-up menu.

2 Prepare the graphic to be an active area by drawing a single text frame around the entire graphic (see “Preparing 
graphics” on page 524).
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3 Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Popup Menu command in the 
text frame (leaving the frame otherwise empty). This command uses the following syntax:

popup flowname 

In this example, flowname is the flow tag of a text frame you’ll create on a reference page. The flowname cannot 
contain embedded spaces.

4 Draw a text frame on a reference page and assign a flow tag that matches the flowname in the Popup Menu 
command. For information on using the Text Frame tool to draw a text frame, see “Using text with graphics” on 
page 320. For information on assigning flow tags, see “Controlling the flow of text” on page 393.

5 Click in the text frame to place the insertion point, type the menu name in the flow, and press Return. (The first 
item in the text frame will always be considered as the title of the pop-up menu.) The menu name appears in UNIX, 
but not in Windows.

6 Type a menu item in each subsequent paragraph. The contents of each paragraph will appear as a command in 
the pop-up menu. If necessary, widen the text frame so that each item fits on a single line.

7 Follow the instructions in “Creating hypertext links” on page 529 to insert a hypertext command in each line 
except the line that contains the menu name. For example, you can use a Jump to Named Destination command to 
display related information, an Alert command to provide a short message to your readers, or a Popup Menu 
command to display a submenu of items.

The text frame for the pop-up menu described at the beginning of this section might look like the following.

Text frame for sample hypertext pop-up menu

Note: You won’t be able to open the pop-up menu until you insert at least one hypertext marker on the reference page. 

To create a pop-up submenu of hypertext commands:
1 Locate the text frame on the reference page that describes the pop-up menu for which you want to create 
a submenu.

2 Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Popup Menu command in the 
line for which you want the submenu to appear. This command uses the following syntax:

popup flowname 

In this example, flowname is the flow tag of a text frame you’ll create on a reference page. The flowname cannot 
contain embedded spaces.

3 Create the submenu by following steps 4 through 7 in “Hypertext commands” on page 527. However, you can’t 
use a Pop-up Menu command in the submenu, because you can’t create a submenu within a submenu.
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The text frame for the submenu shown at the beginning of this section would have a flow tag of Seals. It might look 
like the following.

Text frame for sample hypertext pop-up submenu

Creating alert messages
You can create a hypertext command to display an alert box that contains a title and a message. If you don’t specify 
a title in the command, the alert box contains the default title “FrameMaker—Alert”.

You can also specify a default title for all hypertext alert boxes in a document. 

To create an alert message:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert one of the following 
hypertext commands:

• To display a hypertext alert box with the default title, insert an Alert command. This command uses the following 
syntax:

alert message 

• To display an alert box with a title other than the default, insert an Alert with Title command. This command uses 
the following syntax:

alerttitle title:message 

In this example, title is the title of the alert box and message is the text you want to display in the alert box. The total 
number of characters in title and message cannot exceed 243 characters. (Each character in a Japanese font counts as 
two characters.)

For example, the following command displays an alert box whose title is “Unavailable” and whose alert message is 
“This document is currently under construction.”

alertitle Unavailable:This document is currently under construction

To specify a default title for alerts in a document:
1 Draw a text frame on a reference page and assign the frame a flow tag of AlertTitle. For information on using the 
Text Frame tool to draw a text frame, see “Using text with graphics” on page 320. For information on assigning flow 
tags, see “Controlling the flow of text” on page 393.

2 Type the default title in the text frame. For example, if “Not Available Online” appears in the flow, that title, not 
“FrameMaker—Alert,” appears in the title bar of any alert box created with the Alert command. 
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The default title will also appear in the title bar of any alert box created with the Alert with Title command in the 
following form, without a title:

alerttitle :message

Creating ways to start or open
You can use hypertext commands to start other applications. For example, a reader can start a database application 
from a view-only document to retrieve and display data. 

You can also use hypertext commands to accomplish the following tasks:

• (UNIX) You can execute UNIX commands. For example, a reader can click an active area to remove backup files. 
You can also send messages to FrameMaker clients by using the Application Program Interface (API). For details, 
see the FDK Programmer’s Guide, which is included in the Frame® Developer’s Kit. 

In addition, you can create hypertext commands that link to a Universal Resource Locator (URL) when the 
document is converted to Hypertext Markup Language (HTML). For information, see “Creating links to Web pages” 
on page 532.

To create a way to start another application in Windows:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Message Client. This command 
uses the following syntax:

message system application path,windowstate 

message winexec application path,windowstate 

In these examples, application is the application filename, path is an optional command-line parameter, and window-
state specifies the state of the window that is opened. The possible windowstate values are as follows.

State Meaning

SW_HIDE Hides the window and activates another window

SW_MAXIMIZE Maximizes the specified window

SW_MINIMIZE Minimizes the specified window and activates the next window in the 
Alt+Tab order

SW_RESTORE Activates and displays the window (If the window is minimized or 
maximized, Windows restores it to its original size and position.)

SW_SHOW Activates the window and displays it in its current size and position

SW_SHOWDEFAULT Sets the show state based on the SW_ flag specified in the STARTU-
PINFO structure passed to the CreateProcess function by the program 
that started the application

SW_SHOWMAXIMIZED Activates the window and displays it as a maximized window

SW_SHOWMINIMIZED Activates the window and displays it as a minimized window

SW_SHOWMINNOACTIVE Displays the window as a minimized window (The active window 
remains active.)
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If you omit the windowstate value, the window state is set to SW_SHOWNORMAL. For more information on 
window states, see the documentation for the Windows software development kit.

For example, to start PaintBrush and open the Ship.pcx file on drive C in a minimized window, you would use the 
following command:

message system pbrush.exe C:/Ship.pcx, SW_MINIMIZE 

For an explanation of the use of the forward slash rather than the backslash, see “About pathnames in commands” 
on page 528.

To create a way to open a file or another application:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Message Client command. This 
command uses the following syntax:
message openfile pathname 

In this example, pathname is the path to the file, application, or AppleScript script.

For example, to start the application that created the Tuba.eps file (located in the Graphics folder on the drive named 
HardDrive) and to open the file, use the following command:

message openfile /HardDrive/Graphics/Tuba.eps 

To run the DocReport script (located in the Scripts folder on the drive named HardDrive), use the 
following command:

message openfile /HardDrive/Scripts/DocReport 

For an explanation of the use of the forward slash in pathnames, see “About pathnames in commands” on page 528.

To create a way to execute commands in UNIX:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Message Client command. This 
command uses the following syntax:

message system command 

In this example, command is the text of any UNIX command you can type in a UNIX window. 

For example, the following command lists the contents of the folder in which the document resides when the reader 
clicks an active area that contains the command

message system ls ~ 

SW_SHOWNA Displays the window in its current state (The active window remains 
active.)

SW_SHOWNOACTIVATE Displays a window in its most recent size and position (The active 
window remains active.)

SW_SHOWNORMAL Activates and displays a window (If the window is minimized or maxi-
mized, Windows restores it to its original size and position.)

State Meaning
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In this example, FrameMaker passes the command to sh(1) for execution; stdout and stderr are redirected to your 
UNIX window. FrameMaker waits for the command, script, or program to finish before continuing. 

You can use the environment variables FMDOCDIR and FMDOCNAME with the message system command. 
When the reader clicks an active area that contains the command, FMDOCDIR is set to the folder that contains 

the current document and FMDOCNAME is set to the name of the current document. 

To create a way to send messages to an application that is already running in UNIX:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert a Message Client command. This 
command uses the following syntax:

message application parameters 

In this example, application is the name of the application, and parameters are any parameters to be passed to the 
application. For example, the following command causes an API client named ProductionCheck to process all files 
in the Guide folder:

message ProductionCheck Guide/*

Creating ways to close or exit
The hypertext commands for closing files and exiting FrameMaker work in the same way as the commands on the 
File menu.

If a reader executes a command to close a file that contains unsaved changes, FrameMaker prompts the reader to 
save the document before closing. 

To create a way to close documents:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert one of the following 
hypertext commands:

• To create a way to close the current view-only document, insert a Close active window command. This command 
uses the following syntax:

quit 

• To create a way to close all open view-only documents, insert a Close All Hypertext Windows command. The 
Close All Hypertext Windows command also closes view-only documents that have already been closed to an 
icon. This command uses the following syntax:

quitall

To create a way to exit FrameMaker:
❖ Follow the instructions in “Inserting hypertext commands” on page 525 to insert an Exit command. This 
command uses the following syntax:

exit
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Testing and troubleshooting hypertext documents
After writing the document and inserting hypertext commands, test the commands. To speed up your testing of 
hypertext commands, you can execute commands without first changing a document to View Only format and you 
can force the destination of a hypertext jump to appear in a separate window.

You can also have FrameMaker validate all the commands in a document.

Note: In UNIX, to switch several documents at a time between View Only format and Document format, use fmbatch 
(see “Starting fmbatch” on page 624).

To execute a hypertext command without changing the document to View Only format:
❖ Do one of the following:

• (Windows) Control-Alt-click an active area.

• (UNIX) Control-right-click an active area.

FrameMaker executes the hypertext command as if the document were view-only. 

To force the linked destination to appear in a different window:
❖ Do one of the following:

• (Windows) If the document is view-only, Shift-click an active area. Otherwise, Control-Alt-Shift-click an 
active area.

• (UNIX) If the document is view-only, Shift-click an active area. Otherwise, Shift-Control-right-click an 
active area.

To validate all the commands in one or more documents:
1 Make the appropriate document window or book window active. If a book window is active, select the documents 
you want to affect.

2 Press Esc v h. FrameMaker checks each hypertext command. For example, if a command refers to another 
document, FrameMaker attempts to open the document; and if the command refers to a named destination, 
FrameMaker verifies that the destination exists. If any problems are found, an alert message describes the first error 
in the document. In a book, all errors are written in the Book Error Log.

Generating a list or index of hypertext markers
You can quickly check the text of hypertext commands by generating a list or index of hypertext markers. The 
generated list will contain the text of all hypertext markers inserted on body pages and their page numbers.

To generate a list or index of markers:
❖ Use the Special > List of > Markers or Special > Index of > Markers command. For information on generating 
from a document, see “Generating TOCs and other lists” on page 414 and “Generating indexes” on page 425. 
For information on generating from a book, see “Adding files to books” on page 456 and “Updating books” on 
page 466.
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Troubleshooting hypertext documents
Errors in hypertext commands or in their placement in the document, or formatting errors in active areas can cause 
problems with the behavior of the commands. For example, an incorrect linkname will prevent a hypertext 
command from being executed correctly.

This section describes some common hypertext problems and possible solutions.

Clicking an active area has no effect Check for the following possible problems:

• The document might not be in View Only format.

• If the active area is highlighted correctly when you click, a command may contain a linkname that doesn’t match 
the corresponding link at the destination.

• If the active area isn’t highlighted when you click, the marker that contains the hypertext command may not be of 
type Hypertext.

• If the active area is over a graphic, the text frame containing the hypertext marker may not be in front of 
the graphic.

The jump goes to the wrong page The command may contain a correct filename but an incorrect linkname or an 
invalid page number.

Only part of the active area is highlighted Check for the following possible problems:

• If you’re trying to make a range of text active, the text may contain an extra hypertext marker or the character 
format may change within the range of text.

• If you’re trying to make an entire empty text frame active, the frame may contain an extra empty paragraph, or 
extra characters or markers.

Items are missing from a pop-up menu The hypertext commands for missing menu items are incorrect. If the 
pop-up menu does not appear, no commands are correct.

Adding hypertext links to generated files
When you generate an index or a list such as a table of contents, FrameMaker can insert hypertext links in the 
generated file. These links can greatly enhance the usefulness of an online index or table of contents. When you click 
a topic or page number in the generated file, the appropriate page in the linked document is displayed.

You can use generated hypertext documents for the following purposes:

• To distribute a generated table of contents or index in View Only format as a navigation tool for your 
online documents.

• To debug documents. (For example, when creating an index, you can generate the index with hypertext links and 
then quickly fix index marker errors by jumping to the exact locations of the markers.)

Generating a list of hypertext markers produces a list of markers drawn only from body pages. Hypertext markers 
on master pages are not included.

You can activate the hypertext commands in a generated document without changing the document to View Only 
format (see “Testing and troubleshooting hypertext documents” on page 540).
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To add hypertext links to a generated file:
❖ Do one of the following:

• From an individual FrameMaker document, select Create Hypertext Links when you use the File > Utilities > 
Compare Documents command.

For more information, see “Comparing document versions” on page 477. 

• When adding a generated file to a book, turn on Create Hypertext Links in the Set Up dialog box. If the generated 
file has already been created, select the generated file in the book window and choose the appropriate Set Up 
command from the Edit menu (such as Set Up Table of Contents).

For complete information on generating lists and indexes, see “Generating TOCs and other lists” on page 414 and 
“Generating indexes” on page 425.

Adding linked thumbtabs to indexes
You can make a generated online index easier to navigate by adding thumbtabs. Readers click on a thumbtab letter 
to display the page in the index that contains entries starting with that letter. 

To add thumbtabs to a generated index:
1 Generate the index with hypertext links. See “Adding hypertext links to generated files” on page 541.

2 In the index, choose View > Master pages.

3 On a master page, use the Text Line tool to create the thumbtab letters and then draw a text frame over each 
thumbtab letter (see “Using text with graphics” on page 320). 

4 Insert a Jump to Named Destination command in the text frame for each thumbtab letter (see “Creating links to 
specific topics” on page 530). For example, in the text frame over the thumbtab letter A, insert a Jump to Named 
Destination command with the syntax gotolink A. (Each group title in the index already contains a corresponding 
Specify Named Destination command as a result of generating the index with hypertext links.)

If the index contains a collapsed group title, such as P–R, insert a Jump to Named Destination command with the 
same syntax for each of the thumbtab letters in the range. For example, insert gotolink P-R in the three text frames 
for P, Q,  and R.

5 If the index uses more than one master page, copy the thumbtabs to the other master pages.

6 Save the index in View Only format.

Controlling how source documents are displayed
When you click an active area in a generated hypertext document, FrameMaker opens a new window and 
displays the correct page in the linked document. The linked marker or paragraph is highlighted and centered in the 
window. You can change the display of the linked document—for example, to display the document in the active 
window.

To control how a linked document is displayed:
1 Generate the hypertext document (see “Adding hypertext links to generated files” on page 541).

2 In the generated file, choose View > Reference Pages and display the reference page that contains the special flow 
for the generated file.
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The flow tag of the special flow is the same as the document’s suffix. For example, the special flow for a table of 
contents is tagged TOC, and the special flow for an index is tagged IX. To determine a flow’s tag, click in the text 
frame and look in the Tag area of the status bar.

Your flow tags are displayed in the tag area of the status bar.

3 In the special flow, find the paragraph that controls how the linked document is displayed.

In a table of contents, the paragraph’s tag is ActiveTOC; in an index, it’s named ActiveIX. The paragraph will look 
something like this:

openObjectId <$relfilename>:<$ObjectType> <$ObjectId>

To determine a paragraph’s tag, click in the paragraph and look in the Tag area of the status bar.

4 Edit the paragraph so that it contains the display command you want.

For a list of the commands you can use, see “Display commands for generated documents” on page 543. In addition 
to the commands in the list, you can use the Message Client command to send messages to applications that use the 
Application Program Interface (API). For details, see the FDK Programmer’s Guide, which is included in the Frame 
Developer’s Kit.

5 Save the generated file, and then regenerate it. 

Display commands for generated documents
When the reader clicks an active area in a generated hypertext document, FrameMaker displays the correct page in 
the linked document. The following table lists some of the hypertext commands you can use to control how the 
linked document is displayed. You should type the commands exactly as shown. Use the <$relfilename> building 
block to create a relative pathname from the generated file to the linked document, and use <$fullfilename> for a full 
pathname. (The following examples show only the <$relfilename> building block.)

To display Type

The linked marker or paragraph centered in the active 
window

gotoObjectId <$relfilename>:<$ObjectType> <$ObjectId>

The linked marker or paragraph centered in the active 
window resized to fit the page

gotoObjectIdFitWin <$relfilename>:<$ObjectType> <$ObjectId>

The linked marker or paragraph centered in a new 
window

openObjectId <$relfilename>:<$ObjectType> <$ObjectId>

The linked marker or paragraph centered in a new 
window resized to fit the page

openObjectIdFitWin <$relfilename>:<$ObjectType> <$ObjectId>

The page containing the linked marker or paragraph, 
with nothing highlighted, in the active window

gotopage <$relfilename>:<$pagenumonly>

The page containing the linked marker or paragraph, 
with nothing highlighted, in a new window

openpage <$relfilename>:<$pagenumonly>

An alert that displays the filename of the linked 
document

alert <$relfilename>
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Overriding the generated file’s display command
You can specify how a specific document is displayed, overriding the display command contained in the ActiveTOC 
or ActiveIX paragraph in the generated file. For example, you may want a generated index that references several 
files, including a glossary file, to display the glossary in one window and all the other files in another window.

To override the display command for a linked document:
1 Draw a text frame on a reference page in the linked document, and assign the frame the flow tag HypertextLinks. 
For information on using the Text Frame tool to draw a text frame, see “Using text with graphics” on page 320. For 
information on assigning flow tags, see “Changing flow tags and Autoconnect” on page 393.

2 Do one of the following:

• To display the document in the same window, type gotoObjectId

• To display the document in a different window, type openObjectId

3 Save the document and regenerate (see “Generating TOCs and other lists” on page 414 and “Generating indexes” 
on page 425). When you click in the generated file, the linked document will be displayed using the command 
specified in the HypertextLinks flow, rather than using the command in the ActiveTOC or ActiveIX paragraph.

Incorporating generated files into an online system
If you’re using a generated hypertext document as a debugging tool, the document is ready to use when you generate 
it. If, however, the generated file is going to be part of a hypertext online system, you may want to do the following 
before distributing the documents to your readers in View Only format:

• Set up links from the documents back to the generated file. You can use any of the hypertext commands. For 
example, you can create an Index or Table of Contents button that jumps back to the generated file.

• Add active areas to the master pages of documents for navigating through the online system. For example, you can 
create buttons for paging forward and backward.

• Add links to other parts of the online system in the source documents and in generated files.

Working in view-only documents and books
You distribute online documents and books in View Only format. Readers can view, search, copy, and print—but not 
edit—a view-only document or book using FrameMaker. 

Readers will see the contents of a view-only document exactly as it appeared when you made it view-only. Before 
changing a document to View Only format, use the View menu to turn off the display of the grid, the ruler, text 

symbols, and borders. To display a view-only document without the menu bar or scroll bars, see the online manual MIF 
Reference.

To save a document in View Only format:
1 Choose File > Save As.

2 Specify View Only format and click Save.

To switch several documents at a time between View Only format and Document format, select the files in the book 
and press Esc Shift+f l (lowercase L) k. Choose the check box, and click Continue.
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To save a book in View Only format:
1 In the book window, choose File > Save Book As.

2 Specify View Only format and click Save.

When a view-only book is open, you can click  and  to toggle between displaying filenames and text.

To change a document to View Only format without saving it:
❖ Do one of the following:

• Choose Special > Hypertext and click Make View-Only.

• Press Esc Shift+f l (lowercase L) k. This keystroke also works for a book.

To change a view-only document to Document format:
❖ Do one of the following:

• If the Hypertext dialog box is open, click Make Editable.

• Press Esc Shift+f l (lowercase L) k. This keystroke also works for a book.

To make a view-only book editable or an editable book view-only:
1 In the book window, select any documents that you want to change from view-only to Document format.

2 Press Esc Shift+f l (lowercase L) k.

3 To make the selected files editable, click the check box. To make the selected files view-only, deselect the 
check box.

4 Click Continue.

Navigating to specific pages
You can display pages in view-only documents by following links in the documents, by using controls in the 
document window, or by using menu commands.

To navigate to specific pages in view-only documents:
❖ Do one of the following:

• Click any active area whose hypertext command jumps to a different location.

• Click the page buttons in the status bar.

• Use the scroll bar or the Page Up and Page Down keys.

• Use the commands on the Navigation menu.

• Right-click anywhere in the document window and choose a command from the context menu.

If you customized your view-only window environment as described in the online manual MIF Reference, some 
viewing methods may not be available. 

Jumping backward or forward
You can jump back to previous links and then jump forward again. 
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To jump backward:
❖ Do one of the following:

• Click an active area with a Jump Back or Jump Back & Fit to Page command.

• Choose Navigation > Go Back.

• Right-click anywhere in the document window and choose Go Back from the context menu.

To jump forward:
❖ Press Esc v Shift+n. You can jump forward only if you have previously jumped backward.

Opening a new window
If a link is set to display a document in the active window, you can force FrameMaker to open a new window instead. 

To open a new window when following a link:
❖ Shift-click an active area. In Windows, FrameMaker doesn’t open a new window unless the link is to a 
different document.

Using menu commands
Some FrameMaker commands are available in view-only documents. For example, you can copy text and 
graphics from a view-only document and paste them in an editable document, search for text and paragraph tags, 
and print.

View-only document windows use four FrameMaker menus: File, Edit, Navigation, and Windows. In order to use 
some menu commands, you have to place an insertion point. Other menu commands, such as Edit > Copy, require 
you to select items. View-only book windows use three FrameMaker menus: File, Edit, and Windows. 

If you customized your view-only window environment, some commands may not be available. For information on 
disabling commands, see the online manual MIF Reference.

To place the insertion point or to select an object in a view-only document:
❖ Control-click.

To select in a view-only document:
❖ Hold down Control and select text as you would in an editable document.

Working with FluidView format
A document in FluidView™ format appears as one continuous page, without headers, footers, or margins. When you 
resize the document window, the text is reformatted to fit within the width of the new window.

In most cases, you work with FluidView documents just as you work with view-only documents. For example, you 
can click hypertext links to navigate within and between documents. A FluidView document differs from a view-
only document in the following ways:

• Because the document appears on-screen as one continuous page, clicking the Page Up or Page Down button on 
the bottom of the document window displays the previous or next screenful of text instead of the previous or 
next page.
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• The printed version of a FluidView document may not match what you see on the screen. You can use headers and 
footers, multiple columns, and other page layout options to optimize the printed appearance of the document.

To change a document to FluidView format:
1 Click in the text flow that you want to display in FluidView format. Only one text flow in a document can appear 
in FluidView format at a time.

2 Press Esc Shift+v Shift+f. This hides the headers, footers, margins, page breaks, and any background graphics; 
removes multicolumn formatting; and makes the document view-only.

3 Close the document, and when an alert message prompts you to save the document, click Save.

When you save the document in FluidView format and then reopen it, the main text flow (usually tagged A) 
will always appear, even if a different text flow was visible when you changed the document to FluidView 
format. However, when you click an active area that points to another flow, the new flow appears in the 
FluidView document.

To change a FluidView document back to Document format:
❖ Press Esc Shift+f l (lowercase L) k. 

To restore margins, headers, and footers to a FluidView document but keep it view-only:
❖ Press Esc Shift+v Shift+f.

Creating documents for use in FluidView format
Keep in mind the following points as you create FluidView documents:

• When users open a FluidView document that contains more than one text flow, the main flow always appears in 
the document window. However, you can create links to other flows in the document. When a user clicks an active 
area that points to another flow, the new flow appears in the FluidView document.

• Although a FluidView document may be as long as any FrameMaker document, try to keep the length of each 
document under 200 inches. A page break will appear every 200 inches, and footnotes and graphic frames 
anchored at the bottom of a column will appear at these page breaks instead of at the end of the document.

• Set anchored frames in your document to one of three anchoring positions: Below Current Line, At Insertion 
Point, or Run into Paragraph. Frames anchored at positions other than these may produce unexpected results. 

• You can change the view-only window display or selectively disable menu commands. These expert controls are 
available through a Maker Interchange Format (MIF) file. For information on using MIF to set up the view-only 
window, see the online manual MIF Reference.

Changing side-head area setup
You can use side heads in one format and not in the other. For example, you can display headings in the side-head 
area in FluidView and in the body-text area in the printed copy.

To set up different side-head areas in Document format and FluidView format:
1 Use Format > Page Layout > Column Layout to turn side-head formatting on or off while the document is in 
Document format (see “Creating side heads” on page 122).

2 Press Esc Shift+v Shift+f to change the document to FluidView format.
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3 Press Esc j p Shift+s to turn side-head formatting on or off in FluidView. For information on setting up side heads, 
see “Formatting text as headings” on page 121.

Inserting hypertext command elements in structured 
documents
A hypertext document is the same as any other Adobe FrameMaker document except that it is saved in View Only 
format so that readers cannot edit it. The document can have structure, and you can use elements to embed hypertext 
commands in the active areas. But the structure does not have any effect on how the reader works with the finished 
document.

When working with structured documents, you can insert a hypertext command using an element; in all 
other respects, you set up a hypertext document as described for structured documents the same as 
unstructured documents.

To insert a hypertext command using an element:
1 Click in an area that has been prepared for hypertext. 

2 Select a hypertext element in the Element Catalog and click Insert.

3 If the Attributes for New Element dialog box appears, enter attribute values for the element and click Insert 
Element (see “Inserting elements” on page 36). 

4 Choose a hypertext command from the Command pop-up menu (see “Hypertext commands” on page 527 for 
details). The syntax for the command appears below the pop-up menu, and the command name appears in the 
text box.

5 Enter parameters in the text box (for example, a filename and linkname).

Hypertext commands must be in lowercase. The parameters can be in uppercase or lowercase, but they are case-
sensitive. The entire command can be up to 255 characters long (127 characters on a Japanese-language system).

Note: If you enter a filename parameter for a file that isn’t in the same folder as the current document, you must specify 
a path to the document.

6 If you want FrameMaker to check for errors in the command, select Validate Command upon Insertion.

7 Click New Hypertext Marker. If text symbols are showing, a marker symbol  appears in the document window. 
A bubble for the marker appears in the Structure View, with a text snippet that shows the hypertext command.

FrameMaker checks the syntax for errors. If Validate Command upon Insertion is selected, it also checks the 
command. For example, if the command is Jump to Named Destination, FrameMaker verifies that the destination 
link exists in the specified document. If it finds an error, an alert message describes the error but the command is 
still inserted.


